Chapter 381

Mixed Models Tests for Two Means in a 3-Level Hierarchical Design (Level-2 Randomization)

Introduction

This procedure calculates power and sample size for a three-level hierarchical mixed model which is randomized at the second level. The goal of the study is to compare two group means. The study may be cross-sectional or longitudinal.

In a cross-sectional version of this design, students (first level units) are nested in classrooms (second level units) which are nested in schools (third level units). Each classroom is randomized into one of two intervention groups; e.g., treatment and control.

In a longitudinal version of this design, repeated measurements (first level units) are nested in patients (second level units) which are nested in clinics (third level units). Each patient is randomized into one of two intervention groups; e.g., treatment and control.

Note that companion procedures analyze the other cases in which the randomization occurs at the first, or third, level units.

Technical Details

Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.3.2, pages 191-194. The hierarchical mixed model used for the analysis is

\[ Y_{ijk} = \beta_0 + \delta X_{ijk} + u_i + u_{j(i)} + e_{ijk} \]

where

- \( Y_{ijk} \) is the continuous response of the \( k^{th} \) level-1 unit of the \( j^{th} \) level-2 unit of the \( i^{th} \) level-3 unit.
- \( \beta_0 \) is the fixed intercept.
Mixed Models Tests for Two Means in a 3-Level Hierarchical Design (Level-2 Randomization)

\(\delta\) is the treatment effect of interest. It is the difference between the two group means. 

\(X_{ijk}\) is an indicator variable that is 1 if \(j^{th}\) unit is in group 1 and 0 if it is in group 2. 

\(u_i\) is the level-3 random intercept effect for the \(i^{th}\) level-3 unit. It is distributed as \(N(0, \sigma^2_3)\). 

\(u_{j(i)}\) is the level-2 random intercept effect for the \(j(i)^{th}\) level-2 unit. It is distributed as \(N(0, \sigma^2_2)\). 

\(e_{ijk}\) is a random error term which is distributed as \(N(0, \sigma^2_e)\). 

\(\sigma^2_u\) is variance of the level two (cluster) random effects. 

\(\sigma^2_e\) is variance of the level one (subject) random effects. 

\(\sigma^2\) is the variance of \(Y_{ijk}\), where \(\sigma^2 = \sigma^2_e + \sigma^2_2 + \sigma^2_3\). 

\(\rho_1\) is the correlation among level-1 units which are in a particular level-2 unit. For fixed models like this, \(\rho_1 = \text{corr}(Y_{ijk}, Y_{ij'k'}) = (\sigma^2_2 + \sigma^2_3)/\sigma^2\). 

\(\rho_2\) is the correlation among level-2 units which are in a particular level-3 unit. For fixed models like this, \(\rho_2 = \text{corr}(Y_{ijk}, Y_{ij'k'}) = (\sigma^2_3)/\sigma^2\). 

\(C\) is the number of level-3 units. 

\(K_1\) is the number of level-2 units per level-3 unit assigned to group 1. 

\(K_2\) is the number of level-2 units per level-3 unit assigned to group 2. 

\(M\) is the number of level-1 units per level-2 unit. 

The test of significance of the \(X_{ijk}\) term in the mixed model analysis is the test statistic of interest. It tests the difference of the two group means. Since these are asymptotic results, the specific type of mixed model is not stated. 

Assume that \(\delta = \mu_1 - \mu_2\) is to be tested using a z-test (large sample). The statistical hypotheses are \(H_0: \delta = 0\) vs. \(H_a: \delta \neq 0\). The test statistic is the regression coefficient of the \(X_{ijk}\) term in a mixed model. It is given by 

\[
z = f((\bar{Y}_1 - \bar{Y}_2), C, K_1, K_2, M, \sigma, \rho_1, \rho_2)
\]

where 

\[
\bar{Y}_g = \frac{1}{CK_gM} \sum_{i=1}^C \sum_{j=1}^{K_g} \sum_{k=1}^M Y_{ijk}, \quad g = 1,2
\]

The power can be calculated using 

\[
\text{Power} = \Phi \left( \frac{\delta}{\sigma} \sqrt{\frac{CK_2M}{f_2(1 + \frac{1}{\lambda})}} - \Phi(1 - \alpha/2) \right)
\]

where \(\lambda = K_1/K_2\) and \(f_2 = 1 + M\rho_1 - M\rho_2\).
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are $\delta$, Power, $C$, $K_1$, and $M$.

Under most situations, you will select either Power to calculate power or $K_1$ to calculate the number of level-2 units. Occasionally, you may want to fix $K_1$ and $K_2$ and calculate $C$ or $M$.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found. This search considers only integer values of $C$, $K_1$, or $M$.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as $0.8$ to $0.95$ by $0.05$ may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as $0.01, 0.05, 0.10$ or $0.01$ to $0.10$ by $0.01$. 
Sample Size

C (Level 3 Units)
This is the number of level 3 units in group 1 (treatment group). The sample size for this group is equal to Ceiling(C1 * K * M).

Examples of level 3 units are schools, clinics, hospitals, or cities.
A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive integer.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

K1 (Level 2 Units Assigned to Group 1)
Enter the average number of level 2 units per level 3 unit that are assigned to group 1 (treatment group). The sample size for this group is equal to Ceiling(C * K1 * M).

Examples of level 2 units are classrooms or patients. A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units. A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number. Decimal values such as 4.5 can be entered.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

K2 (Level 2 Units Assigned to Group 2)
This is the number of level 2 units per level 3 in group 2 (control group). The sample size for this group is equal to Ceiling(C * K2 * M).

Examples of level 2 units are classrooms or patients. A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units. A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number. Decimal values such as 5.7 can be entered.

Using Multiples of K1
If you simply want a multiple of the value for group 1 (K1), you would enter the multiple followed by "K1", with no blanks. If you want to use K1 directly, you do not have to enter the leading "1". For example, all of the following are valid entries: K1, 2K1, 0.5K1, and 1.5K1.
You can use a list of values such as "10 20 30" or "K1 2K1 3K1".

M (Level 1 Units Per Level 2 Unit)
This is the average number of level 1 units in each level 2 unit. Examples of level 1 units are repeated measurements or students.
A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units. A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number that is at least 1. It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up to the next largest integer.
You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.
Effect Size

\( \delta \) (Mean Difference = \( \mu_1 - \mu_2 \))

Enter a value for the difference between the means of groups 1 and 2 at which the design is powered. That is, the power is the probability of detecting a difference of at least this amount. This value is not necessarily the true mean difference. Rather, it is the difference you want to be able to detect.

Range

\( \delta \) can be any non-zero value (positive or negative). Since this procedure uses a is a two-sided test statistic, you will get the same result with either positive or negative values.

The difference has the same scale as the standard deviation.

You can enter a single value such as 10 or a series of values such as 10 20 30 or 5 to 50 by 5.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

\( \sigma \) (Standard Deviation)

Enter the standard deviation of an individual observation, \( Y_{ijk} \). This standard deviation applies for both groups.

Note that \( \sigma \) must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7 9 or 1 to 9 by 2.

Press the small ‘\( \sigma \)’ button to the right to obtain calculation options for estimating the standard deviation.

\( \rho_1 \) (Correlation Among Level 1 Units)

This is the correlation of each pair of level 1 units in a particular level 2 unit.

Possible values are from 0 to just below 1. For fixed slope models, \( \rho_1 \geq \rho_2 \). Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.

\( \rho_2 \) (Correlation Among Level 2 Units)

This is the correlation of each pair of level 2 units in a particular level 3 unit.

Possible values are from 0 to just below 1. For fixed slope models, \( \rho_1 \geq \rho_2 \). Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.
Example 1 – Calculating Power

Suppose that a three-level hierarchical design is planned in which there will be students (level-1) which are nested in classrooms (level-2) which are nested in schools (level-3). This analysis will calculate the power for detecting the difference between two interventions in average response for a given configuration of students, classrooms, and schools. There will be one measurement per student and treatments will be applied to classrooms (level-2 units).

The analysis will be a mixed model of continuous data. The following parameter settings are to be used for the power analysis: \( \delta = 0.8; \sigma = 2.6; \rho_1 = 0.01; \rho_2 = 0.005; K_1 = 3, 4, 5; K_2 = K_1; M = 5, 10, 15; \) and \( \alpha = 0.05 \).

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Means in a 3-Level Hierarchical Design (Level-2 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C (Level 3 Units)</td>
<td>5</td>
</tr>
<tr>
<td>K1 (Level 2 Units Assigned to Group 1)</td>
<td>3 4 5</td>
</tr>
<tr>
<td>K2 (Level 2 Units Assigned to Group 2)</td>
<td>K1</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level 2 Unit)</td>
<td>5 10 15</td>
</tr>
<tr>
<td>( \delta ) (Mean Difference = ( \mu_1 - \mu_2 ))</td>
<td>0.8</td>
</tr>
<tr>
<td>( \sigma ) (Standard Deviation)</td>
<td>2.6</td>
</tr>
<tr>
<td>( \rho_1 ) (Correlation Among Level 1 Units)</td>
<td>0.01</td>
</tr>
<tr>
<td>( \rho_2 ) (Correlation Among Level 2 Units)</td>
<td>0.005</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for a Three-Level Hierarchical Mixed Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>0.4643</td>
</tr>
<tr>
<td>0.7431</td>
</tr>
<tr>
<td>0.8854</td>
</tr>
<tr>
<td>0.5791</td>
</tr>
<tr>
<td>0.8548</td>
</tr>
<tr>
<td>0.9546</td>
</tr>
<tr>
<td>0.6753</td>
</tr>
<tr>
<td>0.9212</td>
</tr>
<tr>
<td>0.9831</td>
</tr>
</tbody>
</table>
Mixed Models Tests for Two Means in a 3-Level Hierarchical Design (Level-2 Randomization)

**References**

**Report Definitions**
- **Power** is the probability of rejecting a false null hypothesis. It should be close to one.
- **N** is the total number of level-1 units.
- **C** is the number of level-3 units.
- **K1, K2** are the average number of level-2 units per level-3 unit assigned to groups 1 and 2, respectively.
- **M** is the average number of level-1 units per level-2 unit.
- **δ** is the mean difference ($μ_1 - μ_2$) in the response at which the power is calculated.
- **σ** is the standard deviation of the level-1 responses.
- **ρ1** is the correlation among level-1 units in a particular level-2 unit.
- **ρ2** is the correlation among level-2 units in a particular level-3 unit.
- **Alpha** is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.

**Summary Statements**
The total sample size of 150, which were obtained from 5 level-3 units with 3 level-2 units in group one and 3 level-2 units in group two and an average of 5 level-1 units per level-2 unit, achieve 46% power to detect a difference between the group means of at least 0.80. The standard deviation of level-1 units is 2.60. The correlation of level-1 units within a level-2 unit is 0.010. The correlation of level-2 units within a level-3 unit is 0.005. A test based on a mixed-model analysis is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

**Plots Section**
These plots show the power versus the level-1 count for the three values of K1.
Example 2 – Calculating Sample Size (Number of Level 2 Units)

Continuing with the last example, suppose the researchers want to determine the number of level 2 units needed to achieve 90% power for the values of M.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Means in a 3-Level Hierarchical Design (Level-2 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab | 
Solve For | K1 (Number Level 2 Units Per Level 3 Unit)
Power | 0.90
Alpha | 0.05
C (Level 3 Units) | 5
K2 (Level 2 Units Assigned to Group 2) | K1
M (Level 1 Units Per Level 2 Unit) | 5 10 15
\( \delta \) (Mean Difference = \( \mu_1 - \mu_2 \)) | 0.8
\( \sigma \) (Standard Deviation) | 2.6
\( \rho_1 \) (Correlation Among Level 1 Units) | 0.01
\( \rho_2 \) (Correlation Among Level 2 Units) | 0.005

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

| Numeric Results for a Three-Level Hierarchical Mixed Model |
| --- | --- | --- | --- | --- | --- | --- | --- | --- |
| Power | 0.9271 | 0.9212 | 0.9546 |
| Total N | 500 | 500 | 600 |
| Level 3 Units C | 5 | 5 | 5 |
| Level 2 Units K1 | 10 | 10 | 5 |
| Level 2 Units K2 | 10 | 5 | 15 |
| Level 1 Units M | 5 | 10 | 15 |
| Diff \( \mu_1 - \mu_2 \) | 0.80 | 0.80 | 0.80 |
| Std Dev \( \sigma \) | 2.60 | 2.60 | 2.60 |
| Level 1 Corr \( \rho_1 \) | 0.010 | 0.010 | 0.010 |
| Level 2 Corr \( \rho_2 \) | 0.005 | 0.005 | 0.005 |
| Alpha | 0.050 | 0.050 | 0.050 |

This report shows the required value of K1 for each of the scenarios.
Example 3 – Validation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) page 195 provide a table in which several scenarios are reported. We will validate this procedure by reproducing the first row of the table. The following parameter settings were for the analysis: power = 0.80; $\delta = 0.3$; $\sigma = 1$; $p_1 = 0.1$; $p_2 = 0.05$; $C = 12$; $M = 5$; and $\alpha = 0.05$. These settings resulted in a value of $K_1$ and $K_2$ (their $N_2^{(0)}$) of 4 and an attained power of 0.865.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Means in a 3-Level Hierarchical Design (Level-2 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>$K_1$ (Number Level 2 Units Per Level 3 Unit)</td>
</tr>
<tr>
<td>Power</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C (Level 3 Units)</td>
<td>12</td>
</tr>
<tr>
<td>K2 (Level 2 Units Assigned to Group 2)</td>
<td>$K_1$</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level 2 Unit)</td>
<td>5</td>
</tr>
<tr>
<td>$\delta$ (Mean Difference = $\mu_1 - \mu_2$)</td>
<td>0.3</td>
</tr>
<tr>
<td>$\sigma$ (Standard Deviation)</td>
<td>1</td>
</tr>
<tr>
<td>$\rho_1$ (Correlation Among Level 1 Units)</td>
<td>0.1</td>
</tr>
<tr>
<td>$\rho_2$ (Correlation Among Level 2 Units)</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total</th>
<th>N</th>
<th>C</th>
<th>K1</th>
<th>K2</th>
<th>M</th>
<th>$\mu_1 - \mu_2$</th>
<th>$\delta$</th>
<th>Std Dev</th>
<th>Level 1 Corr</th>
<th>Level 2 Corr</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8653</td>
<td>480</td>
<td>12</td>
<td>4</td>
<td>4</td>
<td>5</td>
<td>0.3</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
<td>0.050</td>
<td></td>
</tr>
</tbody>
</table>

PASS calculates the same values of $K_1$ and power: 4 and 0.8653.